# Table Of Contents

**Introduction** ........................................................................................................................................... 5

- Overview of SoftConsole .......................................................................................................................... 5
- Getting Started .......................................................................................................................................... 6
- Main Window ........................................................................................................................................... 7
- Main Menu Bar ................................................................................................................................ ........ 8
- Call Details Panel ..................................................................................................................................... 9
  - Call Details ......................................................................................................................................... 9
  - Directory ............................................................................................................................................ 10
- Directory Entry Properties Forms ............................................................................................................ 11
- User Directory Entry Properties .............................................................................................................. 11
- Forwarding Status Form ............................................................................................................................ 12
- Directory Entry Form ............................................................................................................................... 13
  - IP Office Directory Number .................................................................................................................. 13
  - SoftConsole Directory Number ........................................................................................................... 14
- Group Service Status ............................................................................................................................... 15
- BLF Panel ............................................................................................................................................... 16
- Add Members to a BLF Group .................................................................................................................... 17
- Views ....................................................................................................................................................... 17

**Call Handling** ...................................................................................................................................... 19

- Incoming Call Handling .......................................................................................................................... 19
  - Transfer a call without answering ......................................................................................................... 19
  - Transfer a Call (Unsupervised) ............................................................................................................ 20
  - Transfer a Call (Supervised) ................................................................................................................ 20
  - Transfer a Call to Voicemail ................................................................................................................ 21
  - Making an Outgoing Call ...................................................................................................................... 21
  - Using Hold ........................................................................................................................................ 22
  - To Hold a Call Against a Busy Extension ............................................................................................ 22
  - Parking a Call ...................................................................................................................................... 23
  - Collect a parked call ............................................................................................................................... 23
  - Reclaim Calls ...................................................................................................................................... 24
  - Working with Queues ............................................................................................................................ 24
    - Monitor a Queue ................................................................................................................................. 24
    - Answer a Queued Call ........................................................................................................................ 24

**Conferences** ....................................................................................................................................... 25

- SoftConsole & Soft Console & Conference Calls .................................................................................... 25
- Conferencing Held Calls .......................................................................................................................... 26
- Using Conference Rooms .......................................................................................................................... 27
- Viewing Conferences/Adding Users ......................................................................................................... 28

**Features** ............................................................................................................................................... 29

- Features ................................................................................................................................................ 29
- Annotate ................................................................................................................................................ 30
- Intrude .................................................................................................................................................... 30
- Page ......................................................................................................................................................... 31
- Record Call .......................................................................................................................................... 31
- Send Message (Text Message) ................................................................................................................ 32
- Reattempt Transfer ............................................................................................................................... 33
- Using the Dial Pad .................................................................................................................................. 34
- Door Release ......................................................................................................................................... 35
  - Configuration ...................................................................................................................................... 35
- Send Email ............................................................................................................................................ 35

**Administration** .................................................................................................................................. 37

- The Login Form ................................................................................................................................... 37
- IP Office Control Units ............................................................................................................................. 38
Introduction

Overview of SoftConsole

The IP Office SoftConsole is intended primarily for operators and receptionists receiving and distributing incoming calls.

The SoftConsole is designed to work in parallel with a physical phone, the phone providing the operators speech path whilst the SoftConsole provides call controls. Key features are:

- Large display for incoming call information.
- Searchable directory of all IP Office groups and users including status information.
- Visual display of queued calls.
- Visual display of the status of extensions.
- Up to 16 call parking areas.

The SoftConsole cannot be used in full softphone mode, ie. it does not support the PC also being used as a softphone.
Getting Started

1. Select **Start** and then **Programs**.
2. Select **IP Office** and click **SoftConsole**.
3. The Login screen should appear.

![SoftConsole User Guide Page 6](image.png)

4. Each user can have a profile, containing their SoftConsole setup preferences. If you have a profile, use the **Profile** drop-down list to select it.

5. Check that the **User Name** and **Password** are correct.
   - **Call Waiting**: If checked, your phone will receive a call waiting tone when a new call arrives whilst you are on an existing call. This option is ignored if you have multiple call appearances set on your phone (the normal default).
   - **Off Hook Station**: If checked, the SoftConsole is able fully control your phone, ie. answer and end calls through the SoftConsole screen. Only uncheck this option if you have an analog phone where you will have to answer/end calls by picking up/replacing the handset.

6. Click **OK**.

7. If directory access to Microsoft Outlook contacts folder has been selected in the directories configuration form, a Microsoft Outlook warning screen may appear. If the warning screen appears:
   - Select the **Allow access for** checkbox, and then click an amount of time in the list.
   - Click **Yes**. Yes should always be selected to allow SoftConsole to retrieve Outlook contacts.
Main Window

The SoftConsole main screen is divided into the following areas:

- **Menu Bar**
  Commands & actions are available through menus. Some items are only accessible when the right conditions occur e.g. when a call is received.

- **Toolbar**
  The toolbars provide short cuts for options that are frequently used.

- **Call Details Panel**
  The panel contains a side-by-side display of current call information. The panel on the left shows details of the current call. The panel on the right shows the directory, individual extension details or details of a consultation call. It can also show a script file and conferencing information.

- **Queue Panel**
  The Queue panel displays graphical information on the status of calls held in queues.

- **Held Calls Panel**
  All calls held by the SoftConsole user appear here.

- **BLF Panel** (Busy Lamp Field Panel)
  The icons represent dialable numbers. For internal users the icons also indicate users status. The icons can be groups of multiple tabs.

- **Park Slot Panel**
  The panel slot panel can contain up to 16 park slot buttons.
Main Menu Bar

- **File:**
  Save the current SoftConsole setup as a personal profile, login with a different profile or exit the SoftConsole.

- **View:**
  Select to run SoftConsole in full or compact mode. Also select the display language and whether to show or hide the toolbar. If logged on in administrator mode; the BLF, held calls and park slots panels can also be selected as shown or hidden.

- **Actions:**
  This menu contains actions for call handling. Those that are greyed out are not applicable to the current call situation. Keyboard shortcuts for the functions are also shown.

- **Directory:**
  Options to view to search, export and setup the directory.

- **Tools:**
  This menu gives access to menus for the Dial Pad, Door Release, Send Email, View Conference Rooms, Call Voicemail and to configure the SoftConsole.

- **Help:**
  Access to the help system and details about Avaya IP Office SoftConsole.
Call Details Panel
The Call Details panel contains a side-by-side display of current call information. A slider positioned between the two subpanels allows the operator to adjust the size of the panels as required.

The left-hand panel contains details about the current call/calls received or made. The right-hand panel normally contains the searchable directory, however during some actions such as transfer enquiry calls it can show details of the enquiry call.

Call Details
This area can work in two ways. When a single call is in progress (ringing or connected), it shows details of that call (left hand picture). For SoftConsole users with multiple call appearances set, it can also show additional calls when they arrive (right-hand picture). In this later mode, clicking the separate calls shown has the same effect as pressing the matching call appearance buttons on the phone.

For a single call, the detail that can be shown are:

- **Calling Name**
  The IP Office system name associated with the calling number. For external calls this can be a name obtained from a calling number match with the IP Office's directory.

- **Calling Number**
  The CLID telephone number of the caller if available.

- **Called Name**
  The IP Office name associated with the called number.

- **Called Number**
  The extension number the incoming call has been routed to by the IP Office. Typically this is an operator group of which the SoftConsole user is a member.

- **Call Status**
  States the progress of a call. The border around the Call Details Panel changes color to indicate the status of a call.
  - **Red** - Alerting incoming call or alerting outgoing call.
  - **Green** - Connected call (or call still being dialed).
  - **Blue** - Held call.
  - **Yellow** - Returned call. For example a held call that has timeout from hold.
  - **Black** - Idle.

- **Call Duration**
  The length of time that the call has been in its current state (ringing, connected, held).

- **Notes**
  This area displays notes or information about the call, for example, when a call returns the reason for the return. If an annotation is attached to the call, the annotation is shown here.
Directory

The right-hand call panel normally displays the directory. Using the search it is possible to drill down the directory to show details of an individual entry.

The directory can show:

- Directory entries including IP Office users, IP Office groups, numbers from the IP Office directory and numbers from the SoftConsole's own directory.

- Full properties and status of an individual user or group when double-clicked or when they are the only remaining search match.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Extn227</td>
</tr>
<tr>
<td>Number</td>
<td>227</td>
</tr>
<tr>
<td>Busy Status</td>
<td>Busy</td>
</tr>
<tr>
<td>Do Not Disturb Status</td>
<td>Off</td>
</tr>
<tr>
<td>Login Status</td>
<td>Logged in</td>
</tr>
<tr>
<td>Group Status</td>
<td></td>
</tr>
<tr>
<td>Main</td>
<td>In Group</td>
</tr>
<tr>
<td>Absent Message</td>
<td>Back soon</td>
</tr>
<tr>
<td>New Voice Mail Messages</td>
<td>1</td>
</tr>
<tr>
<td>Forwarding Status</td>
<td></td>
</tr>
<tr>
<td>Forward Unconditional</td>
<td>207 (Busy)</td>
</tr>
<tr>
<td>Forward On No Answer</td>
<td>Off</td>
</tr>
<tr>
<td>Forward On Busy</td>
<td>Off</td>
</tr>
<tr>
<td>Follow Me</td>
<td>Off</td>
</tr>
<tr>
<td>Forward Hunt Group Calls</td>
<td>Off</td>
</tr>
</tbody>
</table>

- A script file when the calling number of a call matches a SoftConsole directory number with an associated script.
Directory Entry Properties Forms
Clicking on an entry in the directory and then on ☑ displays a page of properties for that entry. Alternatively double-click on the directory entry to display its properties in the directory panel and then double-click on those again to show then in a directory properties form.

The page can be used to edit some of those properties.

- User Directory Properties
  - Forwarding Status Form
- Directory Entry Form
- Group Service Status

User Directory Entry Properties
This form is accessed by selecting a user in the SoftConsole directory panel and then clicking ☑.

- **User Name:** Cannot be changed.
- **Extension:** Cannot be changed.
- **Full Name:** Shows the user's full name. Cannot be changed.
- **Logged In:** This check box shows the user's current logged in state. Cannot be changed.
- **Do Not Disturb:** Shows whether the user is on Do Not Disturb. The SoftConsole user can change the status.
- **Bar Outgoing Calls:** This check box allows the SoftConsole user to control whether the user can make outgoing calls.
- **Forwarding Button:** Clicking on this button displays the users forwarding settings. See Forwarding Status Form.
- **Group Status:** A list of the Hunt groups that the user belongs. If the group is checked then the user is ‘in group’. The operator can alter the users group status for individual groups.
**Forwarding Status Form**

This form is accessed by selecting a user in the SoftConsole directory panel, clicking ![Check Box] and then clicking **Forwarding**.

The form allows the operator to view and change the forwarding status of a user. Note that the appropriate destination number must be set before the matching follow me or forwarding feature can be enabled.

- **Follow Me**: Redirects the users calls to another number. Call will not ring at the users extension. This is meant to be used for temporary redirection when the user will be away from their own phone but available on another number.
  - **Destination**: The number to receive the follow me calls.

- **Forward Unconditional**: Forward all the users personal calls. To also forward hunt group calls, the Forward Hunt Group Calls option must also be ticked.
  - **Destination**: The number to receive the forward all calls.

- **Forward on Busy**: Forward calls when the user's phone is busy.
  - Note: If the user has call appearance buttons, forward on busy is only applied to calls when all the users call appearance buttons are in use.

- **Forward on No Answer**: Forward calls when the user's phone rings unanswered. The normal default is after 15 seconds.
  - **Destination**: The number to receive calls forwarded on busy or no answer.

- **Forward Hunt Group Calls**: Forward hunt group call. This option only works when Forward Unconditional is also selected and uses the same forwarding number.
Directory Entry Form
These forms are accessed by selecting a directory number in the SoftConsole directory panel and then clicking [ ] . The forms that appears depends on whether the number is from the IP Office system's own directory or from the SoftConsole's local directory.

IP Office Directory Number
The IP Office system with which the SoftConsole is working includes a directory of names and numbers. These are used both for outward dialing and to match names to incoming caller numbers.

Entries in the IP Office directory are available to all IP Office users through SoftConsole, Phone Manager or directory functions on their phones.

The only fields used for an IP Office directory number are the Name and Phone Number. These cannot be changed through the SoftConsole. Changes to IP Office system directory numbers are made through the IP Office configuration.
SoftConsole Directory Number

The SoftConsole PC can include its own directory of numbers. As with IP Office system directory numbers these can be used both for outgoing dialing and to match a name to incoming caller numbers.

When a name match exists in both the IP Office directory and the SoftConsole directory, the name in the SoftConsole directory is shown on the SoftConsole. See Incoming Calls Configuration.

- **Name:** The name to display in the SoftConsole directory and on incoming calls where the calling number matches the number set below.
- **Number:** The number to associate with the name. On some systems this number will need to include an external dialing prefix.
- **Script File:** A simple script file, in either .txt or .rtf format, can be associated with the directory number. When an incoming call's calling number matches the directory entry, the script file is displayed in the SoftConsole's directory panel.
- **Media File:** A media files such as .wav file can be associated with the directory number. When an incoming call's calling number matches the directory entry, the media file is played. This allows distinctive sounds to be associated with calls matching particular directory numbers.
Group Service Status
This form is accessed by selecting a group in the SoftConsole directory panel and then clicking ✓.

When the properties of a group is selected then the Group Service Status is shown.

- **Group Name:**
  The name of the group who's properties are being viewed.

- **Service Status:**
  The SoftConsole user can change a hunt group's status between **In Service** or **Out of Service**.
  Depending on the IP Office configuration, when Out of Service, calls go either to another destination or to voicemail. Note: A third status setting, Night Service, is set either automatically by time settings or by the use of special dialing codes.
BLF Panel
The Busy Lamp Field (BLF) panel displays named icons that represent dialable numbers. When the icon matches an internal IP Office user, the icon also indicate that user's status.

![BLF Panel Screenshot](image)

The panel uses tabs to group different sets of icons. You can switch between which set of icons is displayed by clicking on the tab name.

The icons used for an IP Office user shown below:

- **Unread Voicemail Messages**
  A yellow envelope indicates that the user has unread voicemail messages. The number of messages appear in brackets.

- **User Busy**
  A red circle with white cross indicates the user is busy.

- **Forwarding All**
  A green circle with white arrow indicates that the user's calls are currently all being forwarded.

- **Do Not Disturb**
  A blue circle with white cross indicates that the user's current has do not disturb switched on.

**To use a BLF Icon as a speed dial:**

1. Double-click on the required icon or right-click and select `Call`.

The look and feel of the icons in the BLF panel can be changed in several ways:

**To change the icon view:**

1. Right-click the BLF Panel and select `View`.
2. Select the view type required.
   - Large Icons (Ctrl+Alt+G)
   - Small Icons (Ctrl+Alt+S)
   - List Icons (Ctrl+Alt+I)
   - Details (Ctrl+Alt+D)

**To change the icon arrangement:**

1. Right-click the BLF Panel and select `Arrange`.
2. Select the way you want to arrange the icons.
   - Name Order (Ctrl+Alt+N)
   - Number Order (Ctrl+Alt+M)
   - Status Order (Ctrl+Alt+U)
   - Horizontally (Ctrl+Alt+H) - Available in small icons or large icons view.
   - Vertically (Ctrl+Alt+V) - Available in small icons or large icons view.
Add Members to a BLF Group
Members can be added to a BLF Group from the BLF Panel within the Main window.

To add member from the Main window:

1. View the BLF Group in which the members need to be added.
2. Right click within the BLF Panel.
3. Highlight New, click BLF Group Member. The New BLF Member dialog box appears.
4. Enter the User's Name and the extension number.
5. Click OK to return to the BLF panel.

Note: BLF Members can also be added by:

- Click within the BLF Panel and press Ctrl+Alt+B to show the New BLF Member dialog box. Enter the members name and extension number. Click OK to return to the BLF Panel
- Double click within the BLF Panel to show the Edit BLF Group Properties dialog. Add members as required. Click OK to return to the BLF Panel.

Views
The SoftConsole can be run in compact or normal view modes. In compact mode, none if the panels below the calls details and directory are shown (ie. the queues, held calls and BLF panels are not shown).

To toggle between the views:

1. Click the button or select View and then either Compact View or Normal View.
Call Handling

Incoming Call Handling
When an incoming call is received, the Call Details panel is outlined in red and displays the information about the caller. If, in the SoftConsole directory, a script file is associated with the incoming caller’s number, the script is shown in the right call panel.

1. To answer the call, use any of the following methods:
   - Press Enter.
   - Click on Answer Call button.
   - From the Actions menu, select Answer Call.
   - Pick up the handset if using a conventional telephone.
   - Double click in the Call Details Panel.

2. When a call is answered the caller information is shown in green.
   - If a script is showing, to remove it click on the Close Script button or press Enter again.

3. Start typing the name or number that the caller requires into the SEARCH box (after answering a call the cursor is placed in the box automatically).

4. If a single match is found, its properties are shown. Click or press F2 for an unsupervised transfer.
   - If the matches status is shown as Busy, the call can be put on hold against the extension number by pressing Ctrl+B. The caller is on hold against the extension for 45 seconds or until the destination extension becomes free. The call returns to the SoftConsole indicating why it has been returned, eg. timeout or that the target extension is now free. You can use Ctrl+R to reattempt the transfer.

5. If several possible matches are shown, click on the one required and then click or press F2 for an unsupervised transfer.

Transfer a call without answering.
If the operator recognizes a calling name or number it is possible to transfer the incoming call without answering it.

1. Enter the destination extension number in the SEARCH field.
2. Click or press F2 for an unsupervised transfer.
Transfer a Call (Unsupervised)

A call can be transferred to a user without the transfer needing to be accepted by the target destination. Enter the extension number or user name in the directory SEARCH. If the destination is indicated as free, transfer the call using any of the following:

- Click ☑
- Press F2 for an unsupervised transfer.
- From the Actions Menu select Transfer Call.
- Drag & drop the call onto the extension within the Directory panel.
- Drag & drop the call onto the required BLF.

The incoming call is transferred to the destination extension and cleared from the screen.

Note: The SoftConsole user can be configured to have unanswered calls returned to the SoftConsole. Consult your System Administrator for details on how to configure this option. When a call is returned, (NoAns) is shown in the call details panel.

Transfer a Call (Supervised)

When the operator needs to consult a user to verify that they are free to accept a transferred call, a consultation call is needed. During a supervised transfer, the original call information is shown on the left-hand side whilst details of the consultation call appear on the right-hand side.

To make a consultation call

1. Enter the extension number or user name in the directory SEARCH field.
2. If the extension is free, either click ☑ in the directory panel or press F12.
3. The progress of the outgoing call can be heard.
4. Once the call is answered:
   - To toggle between the two calls press Ctrl+A.
   - If the incoming call is accepted for transfer, complete the transfer by clicking ☑ or pressing Ctrl+T.
   - If however the user does not want to receive the incoming call, finish the consultation call by clicking End or pressing End.
Transfer a Call to Voicemail

If an incoming caller wants to leave a message for a user, then the caller can be directly transferred to the user's Voicemail.

To transfer a call to Voicemail:

1. Either press F3 or from the Actions menu select Voicemail Transfer.
2. Enter the extension number into the Transfer to Voicemail dialog box.
3. Click OK.
4. Alternatively locate the extension number in the directory panel. Select it and then press F3 to transfer the caller to voicemail.

Making an Outgoing Call

To make a call use any of the following methods:

- Dial from the associated physical phone.
- Click ➔ or press F12.
- Double-click on a specific BLF to speed dial it associated number.
- Locate and select a directory entry before clicking ➔ or pressing F12.
Using Hold

To place the current connected call on hold using the SoftConsole, click ✉️ or press F4. To hold and answer the next call in one action, press F7.

Held calls are shown in the Held Calls panel. The time for which a call will remain on hold if the user who held it is free is controlled by the telephone system, the default is 15 seconds. Consult your System Administrator for details on how to configure this option.

The Held Call Panel contains a list of all the SoftConsole users held calls. You can sort the list by clicking the corresponding column header. Clicking a row in the list selects the call so the operator can answer or transfer the call.

The toolbar at the top of the panel allows the following actions.

- ✉️ Answer the Selected Held Call
  Any held call can be answered when the call is in the Held Calls Panel. Select the relevant call and then click this button.

- ⏳️ Answer Longest Held Call
  Answers the call that has been held longest.

- ☑️ Conference with Held Calls
  Creates a conference with the current call and all the held calls.

- ⚪️ Transfer Held Call
  Transfers the selected held call (unsupervised transfer)

Note: Right click in the Held Calls panel causes a pop-up menu to be displayed. It offers the same options as the toolbar buttons.

To Hold a Call Against a Busy Extension

If an extension is busy, a call can be placed on hold against the busy extension number by pressing Ctrl+B. The caller is put on hold until the hold against timeout occurs (45 seconds) or until the destination extension becomes free. The call is then automatically presented back to the operator indicating why it is being returned. The operator can then reattempt the transfer or answer the call.
Parking a Call

It is sometimes necessary to temporarily "park" a call to handle some other tasks (receive a new call) or deal with an interruption. An example of Parking is where an incoming caller needs to speak to someone urgently but they cannot be found. The call can be parked in slot "1", and the specific user paged to pick up the call on "1". Calls will remain parked for a specific length of time before being returned to the operator. Consult your System Administrator for details on how to configure this option.

SoftConsole provides parking slots for 16 calls, all with specific Park ID. When a call is parked in one of the park slots, the button label provides information about the call. When a park slot is vacant, the button label shows the park slot ID. All operators can see when the call is picked up or ended. Calls parked by the operator can be collected by anyone.

- **To park a Call**
  When the call is active in the Current Call Information panel, click a vacant Park Slot within the Park Slot panel to park the call. The parked call is highlighted in red and displays information regarding the call e.g. the source number of call.

- **To Unpark a Call**
  When a call is parked in a Park Slot, click the relevant Park Slot Button to unpark the call.

If a secure a parking slot is required for private use, configure the Park ID with text so a call cannot be unparked using normal dialing. The call can then only be unparked using a park slot button set to the same text.

The default SoftConsole keyboard shortcuts for its 16 park slot buttons are Alt+F1 to F12 for buttons 1 to 12 and then Shift+F9 to F12 for buttons 13 to 16.

Collect a parked call

When you park a call, the call can be unparked by any other IP Office user who knows the park slot number.

To pick up a parked call from an IP Office telephone:

- Dial the default short code, *38*N# replacing N with the park slot number.
- For users with Phone Manager or SoftConsole, who have a park slot button set to the same park slot number, the button will indicate the parked call. They can click on the button to unpark the call.
- On Avaya phones with programmable buttons, those buttons can be programmed to match particular park slot numbers. The button will then indicate when a call in parked in that park slot and can be pressed to unpark the call.

For example: A caller needs to speak to someone urgently but they cannot be found. The call can be parked in slot "1", and the specific user paged to pick up the call on "1". The user can pick up the call from any phone using a short code, e.g. *38*1# (1 being the slot number).
Reclaim Calls
You can attempt to reclaim the last call to which the SoftConsole was connected. This may be useful if you suspect it has been transferred to the wrong number.

To reclaim the last call handled
1. Press F6 or from the Actions menu, select Reclaim Call.

Working with Queues
Calls to a Hunt Group are held in a queue when all available members of the hunt group are busy. You can be a member of a Hunt Group, for example "Main", and automatically be presented with calls to this group. The name of the Hunt Group is displayed in the Calling Name field in the Call Details, Current Call Information Panel. You can also monitor the number of calls being held in a queue for a particular Hunt Group. For details on creating, modifying and deleting a Queue refer to the section called Configuring a queue.

Monitor a Queue
The Queue Mode Panel displays up to eight Queues. They indicate the number of calls currently queued for a specific Hunt Group.

The number of calls held in a queue is indicated by a bar graph with the total number of calls shown at the end of the bar graph. Each call is displayed as a white box if the alarm threshold has not been exceeded. If the number of calls in the queue exceeds the alarm threshold then the calls exceeding the threshold are displayed as an amber box.

The longest length of time a call has been in the queue is indicated in the text box at the end of the graph. The time is updated whenever a call is queued. The time will be displayed in white if the longest wait time alarm threshold has not been exceeded. The time will change to being amber if the longest wait time is exceeded.

When the mouse pointer is moved over an active Queue Call bar the Queue Name, number of calls in the queue, number of Recall calls and the queue status (normal or alarmed) is displayed.

Answer a Queued Call
If you are a member of a Hunt Group a queued call is automatically presented in the Current Call Information panel. The name of the Hunt Group is displayed in the Calling Name field. You can answer the call in the normal way.

If you are not a member of a Hunt group you are able to answer queued calls. To answer a call click on the Queue name button, the first call in the queue is presented to the operator with the Hunt Group name displayed in the Calling Name field. Answer the call in the normal way.
Conferences

SoftConsole & Soft Console & Conference Calls
The SoftConsole can be used to start and add callers to conference hosted by the IP Office telephone system. This can be done in several ways:

- **Conference Held Calls**
  The SoftConsole can place several calls on hold and then start a conference between those calls. See Conferencing Held Calls.

- **Use the SoftConsole's Conference Rooms**
  The SoftConsole has two conference rooms which can be used to prepare a large conference and then invite the indicated conference users to join. If Voicemail Pro is installed, the invitation to join a conference room conference process is automated. See Using Conference Rooms.

- **Viewing Existing Conferences and Add Users**
  The SoftConsole operator can view all existing conferences and add a caller to any of those conferences. See Viewing Conferences

Conference Limitations

Conference Clear Down
For conferences started by IP Office users including the SoftConsole operation, when only two parties are in the conference, if one party leaves the whole conference is ended. This does not apply to conferences started by the IP Office Conferencing Center.

System Conference Capacity
The number of parties, that is both internal users and external callers, that be involved in conferences at the same time is limited by the conference capacity of your IP Office telephone system.

- **IP401:**
  Supports a single 3-way conference.

- **IP403, IP406 and Small Office Edition:**
  Supports multiple conferences totaling up to 63 parties. For example:
  - 21 x 3-way conferences.
  - 1 x 10-way conference (10 parties) plus 11 x 3-way conferences (33 parties) and free capacity for 20 more conference parties to join new or existing conferences.

- **IP412:**
  Supports multiple conferences totaling up to 126 parties but with no more than 63 parties in any one conference.
  - The IP412 supports two 63 party conference banks. When a new conference is started, the bank with the most free capacity is used for that conference. However once a conference is started on one conference bank, that conference cannot use any free capacity from the other conference bank.

In addition to the above:

- System features such as call intrusion, call recording and silent monitoring all use conference resources. This includes automatic recording if enabled. When any of these features is active, the number of slots available for conference parties is reduced.

- If the Avaya IP Office Conferencing Center is installed, this will reserve a proportion of the IP Office systems conferencing capacity for its own operation.

Analogue Line Restriction
In conferences that include external analog lines, only a maximum of two analog lines are supported.
Conferencing Held Calls
Using SoftConsole, multiple calls can be held and then a conference started between the held calls. This is the simplest method for starting a small ad-hoc conference of three or four parties. For larger conferences see Using the Conference Rooms.

To conference held calls:
1. Call and then place each user to be conferenced on hold.
2. Press the Conference button .
3. To remove the yourself from the conference call, click the Hang Up button .
4. Additional callers can be added to the conference by selecting Add to Conference from the Action menu.
Using Conference Rooms
The 1 and 2 buttons in the main toolbar represent the two conference rooms. These can be used to start conferences with multiple members. If Voicemail Pro is available, it can automatically call each party and ask them to join the conference.

For the Conference buttons to be available the conference room names need to have been set up.

To Create a Conference

1. Click either 1 Conference Room 1 or 2 Conference Room 2. A conference window will appear.

2. If the conference room is not currently in use the window will be blank. If in use then the current members of the conference will be shown.

3. In the Conference Description area type the subject of the conference. This will only show on the conference room form and is optional.

4. In the Conference Host area type the name of the person who has requested the conference. This will be shown when viewing current system conferences in the directory panel, see Viewing Conferences.

5. Enter the users for the conference by either:
   - Click the Add Users button and select users from the directory list. Use the shift and ctrl keys to select multiple users in one go.
   - Drag and drop BLFs from the BLF Panel into the window. This method can be used to drag and drop BLF’s that represent external parties.

6. If a user is added by mistake, delete them by right clicking on the BLF and selecting Remove.

7. If Voicemail Pro is present users can be invited by clicking on the Invite button.
   - The BLF icons will show with a blue outline. Each user is rung and invited to the conference. When the users answers they are invited to join the conference by pressing 1, decline the invitation by pressing 2 or indicate that they are unavailable by pressing 3. The Conference BLF’s will change automatically to indicate the status of the call.

8. If Voicemail Pro is not present, the users must be invited manually. Double-click each user BLF icon to call the user and invite them to the conference.
   - If they accept click on either Add to conference room 1 or Add to conference room 2 from the Actions menu.
   - If the user is unavailable or has declined the invitation, end the call. Right click on the BLF and change the status accordingly to record the delegates response.

The invited delegates status is represented by an icon in the Conference Room window.


Once a conference is in progress additional users can be added using Add to conference Room 1 or Add to Conference Room 2 action.
To Change the Conference Room View

- Right click in the Conference Room Window and select **View** from the pop-up menu. Select the view type required.
  - Large Icons
  - Small Icons
  - List Icons
  - Details

To Rearrange the Conference Room View

1. Right click in the Conference Room Window and select **Arrange** from the pop-up menu. Select the way to arrange the icons.
   - by Name.
   - by Number.
   - by Status.

To Change the Status of a User

1. Right click on the users BLF.
2. Select **Change Status**
3. Select the status required from **Not invited**, **Invited**, **Joined**, **Declined**, or **Unavailable**.

Viewing Conferences/Adding Users

The SoftConsole directory panel can be used to view current conferences on the IP Office telephone system. This will include ad-hoc conference started by other users and in the SoftConsole's conference rooms. If the IP Office Conferencing Center is installed, conference it is running will also be displayed.

To view action conference click in the Directory panel. For SoftConsole Conference Room conferences and IP Office Conferencing Center conference the conference name and host are shown. For other conferences just the conference number is shown.

Adding a Caller to a Conference

This view can also be used to add a caller to a conference including Conferencing Center conferences.

1. Answer or make a call to the user.
2. Click in the Directory panel to display the current conferences.
3. Click on the required conference in the list.
4. Select **Actions** and then **Add to Conference**.
Features

The Actions menu contains commands for:

- **Reclaim Call**: Return the last handled call to SoftConsole.
- **Alternate Calls**: Toggle between a consultation call and original incoming call.
- **Answer Call**: Answer the incoming call.
- **Annotate**: Associate a text annotation with a call.
- **New Call**: Start a new call.
- **Conference**: Conference the current call with all calls that are on hold.
- **Hang up**: Disconnect from the current call.
- **Hold**: Place the current call on hold.
- **Hold Call and Auto-Answer Next Alerting Call**: Place the current call on hold and if another call alerts the operator's station within one second, then that call is automatically answered.
- **Hold Against**: Place the current call on hold against a specific extension number.
- **Intrude**: Intrude upon a user who is active on a call.
- **Page**: Activate the paging feature.
- **Record Call**: Turns on call recording.
- **Send Message**: Allows the operator to send a message to a user that is visible either on the user's telephone display or through phone manager.
- **Transfer Call**: Transfer the current call.
- **Transfer Complete**: Complete a supervised transfer.
- **Reattempt Transfer**: Transfer a call that is returned to the operator.
- **Voicemail Transfer**: Transfer a call to a user's Voicemail.
- **Add to Conference**: Transfer a call into a Held calls conference.
- **Add to Conference Room 1**: Add a call to Conference room 1.
- **Add to Conference Room 2**: Add a call to Conference room 2.
- **Pick Queue**: Pick up a call from a Queue.
- **Park**: Park a call. Lists the available park slots.
- **Unpark**: Retrieve a parked call. Lists the park slots containing a parked call.

The Tools Menu contains commands for:

- **Dial Pad**: Show the pop up Dial Pad form.
- **Door Release**: Open controlled doors without leaving the desk.
- **Send Email**: Send a message to a user via the email system.
- **Call Voicemail**: Connect to the Voicemail for the user that is logged into SoftConsole.
- **Conference Room**: Enter a conference room
Annotate
Text can be associated with a call. This feature is also known as 'Tagging' a call. Alpha & Numeric characters can be used but not commas. By default the length of a message is up to 16 characters. The Administrator can specify the maximum length of call notes.

To Annotate a call:
1. From the Actions menu, select Annotate Call or press F11.
2. Type the required details and click OK.

The Current Call Information panel shows with a notes field containing the text that was entered. When the call is transferred the message is displayed at the extension if the equipment can display text.

Note: The annotation is also shown on the originator's phone if the equipment is capable of displaying text and the call is internal.

Intrude
This is only available if the operator has permission to intrude and the other internal parties have given permission to allow intrude to happen. Consult your System Administrator for details on how to configure this option.

To intrude upon a user who is active on a call:
1. Locate the user in the directory panel.
2. From the Actions menu select Intrude.
   Or
   Press F9.
3. Speak to the User.
4. When finished press the Hang Up button 📞.
   Or
   From the Actions menu select Hang Up
   Or
   Press the End button.
The SoftConsole operator can broadcast a message to a specific group of people. For example, an incoming caller needs to speak to someone urgently but they cannot be found. The call can be parked and then a message broadcast for the user to pick up the call.

To broadcast a message:

1. Click the Page button.
   Or
   From the Actions menu select Page.
   Or
   Press F10
2. Select the group to broadcast to and click OK.
3. Speak the message
4. To end the Page click the Hang Up button.
   Or
   From the Actions menu select Hang Up
   Or
   Press the End button.

Record Call

- Refer to your local regulations in relation to recording calls.
  If Advice of Call Recording (AOCR) is required, speak to your system administrator.

Current calls can be recorded, either a complete call or just part of the call. Recordings will stop when a call is put on Hold or is disconnected. When Conference calls are being recorded the recording will be stopped when another caller is added to the conference.

To record the current call conversation:

- Click the Record Call button.
  Or
- From the Actions menu select Record Call
  Or
- Press F5
  The conversation is recorded into the operators own voice mailbox.

To finish recording

- Click the Record Call Button.
  Or
- From the Actions menu select Record Call
  Or
- Press F5

Notes: Recordings are only supported when VoiceMail Pro is installed.
Send Message (Text Message)
This option allows the operator to send a short text message to a user with an Avaya display phone. Send Message is less intrusive then intruding on the users current call.

The result of using Send Message will depend on the users Avaya phone type and whether they are on a call or not, see below.

- The logged in SoftConsole user must be configured to use Send Message. If the message is not sent refer to Trouble Shooting.
- By default the maximum length of a message is 16 characters. The length is controlled by the Maximum Length for Call Notes setting. This setting can only be altered when running the SoftConsole in Administrator Mode.

To Send a Text Message
1. Locate the user in the directory.
2. From the Action menu select Send Message.
   Or
   Press Ctrl+M
   The user's extension number field will automatically be completed from information showing in the directory.
3. Enter the message and press OK.

Text Message Display on Avaya DS Port Display Phones
- The message causes a single ring and light the phones message lamp. This happens whether the phone is free or on a call.
- If the phone is free, the message text is displayed. If on a call the text is displayed after the user completes the current call.
- On phones with a MENU key, received text message can be displayed by pressing MENU | MENU | Msgs | Recvs.
  - A ▼ over Recvs indicates when there are text messages. Use the ◀ and ▶ keys to move through the text messages if there are several.
  - Press the display key under the number of messages to delete the current message.
  - When complete press ▼ Exit. If there are no text message left the message lamp is extinguished (unless the user also has voicemail messages).
- On other phones only the last message is displayed and this is cleared when the phone is next used or receives a call.

Text Message Display on Avaya DT Port Display Phones
- The message causes displays on the phone. This happens whether the phone is free or on a call. The phone message lamp is also lit. There is no single ring.
- The message is cleared from the display when the phone is next used or receives a call.
- To redisplay the message press ●AGAIN or if there are several messages ●NEXT. To delete the current displayed message press ●CANCEL. When all messages are deleted the message lamp is extinguished (unless the user also has voicemail messages).
Reattempt Transfer

The reattempt transfer action is used to retransfer a returned call to the original transfer extension. The call details panel has a yellow border when a call is returned.

A call can be retransferred when:

- A call was held against a busy extension. The extension becomes free so the call is returned to the operator.
- A call was transferred to a free extension. The call is returned to the operator as the call was not answered and Voicemail was not available.

To reattempt a transfer:

- Click the **Reattempt Transfer** button.
  Or
- From the **Action** menu select **Reattempt Transfer**.
  Or
- Press **Ctrl+R**.

If this feature is not available refer to the section on trouble shooting.
Using the Dial Pad
The operator can use the Dial Pad to dial a phone number from the application.

To start Dial Pad:

1. Click \& or from the Tools menu select Dial Pad.

The required telephone number can be entered into the 'Number to Dial' field by using the dial characters on the Dial Pad or from the keyboard. Notes for the call can be entered in the Call Notes area.

When completed click the Dial button to start the call.
Door Release
The Door Release allows the SoftConsole operator to open controlled doors, without leaving the desk. Two doors can be controlled by the SoftConsole operator. The doors will be released for 15 seconds by default.

To open a door using SoftConsole:
1. From the Tools menu select Door Release.
2. Click the required door name to release the door.
   Note: Before the option Door Release is available to the SoftConsole Operator, the doors need to be configured.

Configuration
1. From the Tools menu select Options and click Door Entry
2. Enter a name for Door 1. The name entered is shown when the option Door Release is selected. Access to the Entry Code field is prevented as the Entry Code for door one is set to 1.
3. Enter a name for Door 2 if required.
4. Click OK.

Send Email
The SoftConsole operator can send a message to a user via Microsoft Outlook.

To send an email message:
1. From the Tools menu select Send Email.
   Or
   Press Ctrl+E.

The email message form will appear. Complete the details as required and send in the usual way.
Administration

The Login Form

When the Login form has been completed click the **OK** button. The Login screen will continue to be displayed until the operator has successfully logged in. During this time the message "Login in progress, please wait...." is displayed at the bottom of the screen. If the Login fails the message "Login unsuccessful. Please try again" is shown. There are several reasons why a Login attempt may fail.

- The incorrect IP Office IP Address
- An invalid user name and/or password has been entered
- There may be network problems
- The operator is not logged into the telephone.

The form needs to be completed with the following information.

- **Profile**
  A drop down list of the available profiles. The chosen profile is the default profile the next time SoftConsole is started.

- **Show Templates**
  Indicates whether templates are included in the Profile drop down menu. To view both Templates and Profiles in the drop down list select this option. The list includes predefined templates.

- **IP Office IP Address**
  The IP Address of the IP Office system. Click the Browse button to select another IP Office system.

- **User Name**
  The user name that is used to log in to the IP Office system

- **Password**
  The password associated with the user name. Each character of the password is displayed as an asterisk.

- **Call Waiting**
  The Call Waiting feature provides a Call Waiting Tone when the operator is on a call and another call is presented. When the existing call is dropped the new call is immediately presented to the operator.

- **Off-hook Station**
  If selected the Off-hook Station feature is turned on for the operator during the current session. This feature is typically used by operators using the hands free features of the telephone. SoftConsole will control the operation of the telephone.
IP Office Control Units

If there is more than one IP Office system available the operator can select the unit to be connected. A listing shows the Unit name, IP Address and version.

To select a Unit:

1. Highlight the unit in the list
2. Click OK.
3. If the required IP Office system is not listed contact your System Administrator.
Administrator Mode
The SoftConsole can be started in Administrator mode. When run in this mode there is no access to telephony functions but the following actions can be performed:

- Change and Create Templates.
- Control which panels (BLF, Held Calls, Park Slots) are viewable.
- Change the Administrator Password.
- Edit the user profiles.
- Specify the Maximum Length of Call Notes.

To Run the SoftConsole in Administrator Mode
1. At the Login screen enter:
   - User name: Administrator
   - Password: password
     This is the default Administrator password which should be changed following installation. The new password should be recorded.

Changing the Administrator Password
1. Start the SoftConsole in Administrator mode.
2. From the File menu select Change Administrator Password.
3. Enter the old password which will show as asterisks.
4. Enter the new password. Make a note of the new password being careful regarding capitalization as the password is case sensitive. The password will appear as asterisks.
5. Enter the new password again to confirm and click OK.

Change and Create Templates
There are predefined templates supplied. New templates can also be created.
1. At the SoftConsole login screen select a predefined template.
2. Login as Administrator.
3. Make changes as required.
4. Save the new template from the File menu, Save Template as option.
5. Enter a name for the template and click OK.

Setting Which Panels are Viewable
When running the SoftConsole in Administrator mode, from the View menu you are able to display or remove the following panels.

- BLF Panel.
- Held Calls Panel.
- Park Slots Panel.
**Editing User Profiles**

1. At the SoftConsole login screen select the user profile you want to edit
2. Login as Administrator.
3. Make changes as required
4. Save the profile from the **File** menu, **Save Profile** option.

**Setting the Maximum Length of Call Notes**

Specify the maximum length of Call Notes. The default is 16 characters. This can be increased but longer notes may not be display fully on some phones and applications.

1. Start the SoftConsole in Administrator mode.
2. Select options.
3. Select the Keyboard Actions tab.
4. Set the **Call Notes** length as required.
Incoming Calls Configuration

This menu allows you to setup directory names and numbers. These can then be displayed in the SoftConsole directory panel along with IP Office users, hunt groups and system directory numbers.

The directory numbers can be used to make outgoing calls. They can also be used to provide a name match against the calling number on incoming calls. You can also associate a specific script and/or media file to be played on calls from a matching number.

1. To access this menu, click and select the Incoming Calls tab or select Tools | Options | Incoming Calls.

2. The menu shows the current SoftConsole directory entries. Select the action to perform using the available buttons:
   - **New**
     Add a new directory entry. See New/Edit Local Directory List.
   - **Edit**
     Edit the currently selected entry. See New/Edit Local Directory List.
   - **Delete**
     Delete the current selected entry.
   - **Open Directory File**
     Change the file being used for storing the SoftConsole directory entries. The entries in the selected file are then listed and used.
   - **Browse for Script File**
     Associate a .txt or .rft file with the current selected directory entry. The file will be displayed in SoftConsole when an incoming number match occurs.
   - **Browse for Media File**
     Associate a .wav file with the current selected directory entry. The file will then be played whenever an incoming number match occurs.

3. Click OK.
Queue Mode

A queue monitor can be configured for a specific Hunt Group. The Hunt Group needs to be created on the System with Queuing enabled. Refer to your System Administrator for more details.

SoftConsole provides you with the ability to configure and monitor up to eight queues. One of the Queues is configured as a Recall Queue.

1. To access this menu, click ☑ and select the Queue Mode tab or select Tools | Options | Queue Mode.

2. The menu shows details of the existing queues.
   - The Recall Queue shows calls to a group containing the SoftConsole that, having been transferred by the SoftConsole, have returned unanswered.
   - For each queue, the alarm thresholds (number of calls and longest waiting call) are shown.

3. To adjust the queues use the buttons provided.
   - New
     Add a new queue to monitor. See New Queue.
   - Edit
     Change the current selected queues settings. See New Queue.
   - Delete
     Delete the current selected queue.
   - Move Up/Move Down
     Adjust the order of display of the queues.

4. The Color Preferences sections allows you to adjust the Normal Conditions color and the Alarm Conditions color used for the queues.

5. The Alarm Handling section allows you to set what should happen when a queue goes over its alarm threshold. The options are:
   - Automatically restore SoftConsole.
   - Ask me whether to restore SoftConsole.
   - Ignore the alarm.

6. Click OK.
Park Slots Configuration
This menu allows you to set how many park slot buttons are available and what park slot Id's should be associated with those buttons.

1. To access this menu, click and select the Park Slots tab or select Tools | Options | Park Slots.
2. Use the buttons to configure the park slot buttons:
   - **New**
     Allows a new button to be added up to a maximum of 16 buttons.
   - **Edit**
     Allows you to change the park slot ID of the current selected button.
   - **Delete**
     Remove the selected park slot from the list
   - **Move Up / Move Down**
     The order of the configured park slots can be changed by moving the selected park slot up or down.
3. Click **OK**.

BLF Groups Configuration
Busy Lamp Field (BLF) icons provide user status and speed dials at a glance. You can also add icons for other numbers though they will only act as speed dials.

By grouping the BLF icons, you can have them display on different named tabs.

1. To access this menu, click and select the BLF Groups tab or select Tools | Options | BLF Groups.
2. The menu displays the name of each group and the names of its members. You can use the control buttons to adjust the BLF groups.
   - **New**
     Create a new group. See Edit BLF Groups.
   - **Edit**
     Edit the current select group. See Edit BLF Groups.
   - **Delete**
     Delete the current selected group.
   - **Move Up**
     Move the group up the list of groups. This changes the position of the tab.
   - **Move Down**
     Move the group down the list of groups. This changes the position of the tab.
3. When the BLF groups are adjusted as required, click **OK**.
Directories Configuration
This menu allows you to specify what directory information should be included in the directory display and what information should be included in the properties of individual entries.

1. To access this menu, click and select the **Directories** tab or select **Tools | Options | Directories**.

2. When is pressed on the directory, it shows directory numbers other than IP Office users and groups. The **Directory Access** options specify from where those other directory numbers are obtained.
   - **IP Office SoftConsole Local Directory**
     These are directory numbers and associated names stored by the SoftConsole. To setup entries in this directory see **Incoming Calls Configuration**.
   - **IP Office Directory**
     These are directory numbers and associated names stored on the IP Office system and shared by all IP Office users.
   - **Microsoft Outlook Contacts Folder**
     This options allows address book entries from Outlook running on the same PC to be included in the directory.

3. When a directory search matches an individual directory entry, the directory panel display a range of information about entry. The **Display Fields for Search Results** options specify which information fields should be shown.
   - The options are: **Phone Number**, **Busy Status**, **Do Not Disturb Status**, **Forwarding Status**, **Forwarding Destination**, **Forwarding Destination Status**, **Mobile Number**, **Fax Number**, **Email Address**, **Login Status**, **Group Status**, **Absent Message**, **New Voicemail Messages**.

4. Click **OK**.

Conferencing Configuration
This menu allows you to name the two conference rooms supported by the SoftConsole. The names appear on the telephone displays of internal users in the conference room. The

1. To access this menu, click and select the **Conferencing** tab or select **Tools | Options | Conferencing**.

2. For each conference room enter the name required. The names can contain up to 10 characters and must be unique.

3. Click **OK**.
Keyboard Mapping Configuration

This menu allows you to see and if required change the keyboard short cuts used by the SoftConsole.

1. To access this menu, click ☐ and select the Keyboard Mapping tab or select Tools | Options | Keyboard Mapping.

2. You can use the Category drop-down to select which sets of short cuts are shown.

3. To change a short cut click on the current short cut keys.
   - Use the drop-down control that appears to select the required new short cut.
   - If the new short cut is already in use a warning is displayed.

4. If required, you can reset all the short cuts back to their defaults by clicking on Reset All.

5. Click OK.

Keyboard Actions

This menu allow you to specify what happens in SoftConsole when you start pressing alphabetic or numeric keyboard characters.

1. To access this menu, click ☐ and select the Keyboard Actions tab or select Tools | Options | Keyboard Actions.

2. Select the required Default Action for Alphabetic Keystrokes. The options are:
   - Begin Directory Search (this is the default setting).
   - Open Call Annotation Window.

3. Select the required Default Action for Numeric Keystrokes. The options are:
   - Begin Directory Search (this is the default setting).
   - Open Pop-up Dial Pad.

4. The next option is only available when running the SoftConsole in Administrator Mode.
   - Maximum Length for Call Notes
     You can specify the maximum length of call notes. The length specified also applies text messages sent with Send Message. The default is 16 characters. If this value is increased the note may not be fully displayed on all phones and applications.

5. Click OK.
**Appearance Configuration**

The menu allows you to change the general appearance of the SoftConsole, ie. the font it uses, the colors used to indicate call status and the whole skin of the application.

1. To access this menu, click 🔄 and select the **Appearance** tab or select **Tools | Options | Appearance**.

2. Changes the settings as required:
   - **Font:**
     Use the drop-down list to select the font required.
   - **Apply Custom Skin:**
     Check this option to select and use a custom skin. A skin is a set of files defining the whole appearance of the SoftConsole. Note that by default no additional skins are supplied with the SoftConsole.
   - **Custom Skin:**
     If **Apply Custom Skin** is selected, this field allows you to browse to the location of the skin definition file.
   - **Call Status:**
     This set of options allow you to set the colors that should be used for the border of the call details panel. Different colors can be set for: **Idle**, **Alerting - Incoming**, **Alerting - Outgoing**, **Connected**, **Held** and **Return Call**.

3. Click **OK**.

**Save Options**

This menu allow you to set how the SoftConsole saves any changes that you make to the screen layout.

1. To access this menu, click 🔄 and select the **Save** tab or select **Tools | Options | Save Options**.

2. Select the save mode required:
   - **Automatically Save Changes to My Profile:**
     In this mode, when you close SoftConsole any profile changes are automatically saved.
   - **Prompt me to Save Changes to My Profile:**
     In this mode, when you close SoftConsole a dialog box will appear. You can then select whether to save or abandon any changes.

3. Click **OK**.
Appendix

Default Templates
When the SoftConsole application is installed the following templates are provided.

- **AdminTemplate1**
  Panels showing: Call Details, Directory Panel, Queue Panel, Held Calls Panel, BLF Panel and Park Slot panel (containing 16 slots)

- **AdminTemplate2**
  Panels showing: As above except BLF panel, ie. Call Details, Directory Panel, Queue Panel, Held Calls Panel, and Park Slot panel (containing 16 slots).

- **AdminTemplate3**
  Panels showing: Call Details, Directory Panel, Queue Panel.

Short Cut Keys
The sections below show the default short cut keys used by SoftConsole. These can all be adjusted through the **Tools | Options | Keyboard Mapping** menu.

The following short cuts are not categorized:

- **Answer call**: Enter
- **Hangup**: End
- **Transfer call**: F2
- **Complete transfer**: Ctrl + T
- **Hold call**: F4
- **Record call**: F5
- **Reclaim call**: F6
- **Hold call and answer next**: F7
- **Hold call against busy extension**: Ctrl + B
- **Reattempt transfer**: Ctrl + R
- **Intrude**: F9
- **Make call**: F12
- **Annotate call**: F11
- **Alternate/toggle calls**: Ctrl + A
- **Add to conference**: Shift + Ctrl + F10
- **Add to conference room 1**: Shift + Ctrl + F11
- **Add to conference room 2**: Shift + Ctrl + F12

The following short cuts are categorized:

**Application**

- **Switch between normal and compact view**: Home
- **Restore minimized SoftConsole**: Pause
BLF / Speed Dial Icons
- Arrange icons by name: Ctrl + Alt + N
- Arrange icons by number: Ctrl + Alt + M
- Arrange icons by status: Ctrl + Alt + U
- Arrange icons horizontally: Ctrl + Alt + H
- Arrange icons vertically: Ctrl + Alt + V
- Icon details view: Ctrl + Alt + D
- Large icon view: Ctrl + Alt + G
- Small icon view: Ctrl + Alt + S
- Icon list view: Ctrl + Alt + I
- Call selected icon: Ctrl + Alt + C
- Create new icon group: Ctrl + Alt + R
- Create new group member: Ctrl + Alt + B
- View icon group/selected icon properties: Ctrl + Alt + P

Directory
- New directory search: Ctrl + S
- Show directory: Ctrl + Y
- Show conferences: Ctrl + F
- Call selected entry: Ctrl + C
- Send email to selected user: Ctrl + E
- Send text message to selected user: Ctrl + M
- Show/hide directory numbers: Ctrl + D
- Show/hide groups: Ctrl + G
- Show/hide users: Ctrl + U
- Display selected entries properties: Ctrl + P

Held Calls
- Answer selected held call: Ctrl + Alt + A
- Answer longest held call: Ctrl + Alt + L
- Conference with all held calls: F8
- Transfer selected held call: Ctrl + Alt + T
Queue Mode

- Pickup call from queue 1: Shift + F1
- Pickup call from queue 2: Shift + F2
- Pickup call from queue 3: Shift + F3
- Pickup call from queue 4: Shift + F4
- Pickup call from queue 5: Shift + F5
- Pickup call from queue 6: Shift + F6
- Pickup call from queue 7: Shift + F7
- Pickup call from queue 8: Shift + F8

Tools

- Call voicemail: Ctrl + V
- Conference Room 1: Shift + Ctrl + F4
- Conference Room 2: Shift + Ctrl + F5
- Dial pad: Shift + Ctrl + F3
- Door release 1: Shift + Ctrl + F1
- Door release 2: Shift + Ctrl + F2
Toolbar Buttons

Main Toolbar
- Login.
- Save Profile.
- New Call.
- Answer Call.
- Hold Call.
- Transfer Call.
- Transfer Complete.
- Reattempt Transfer.
- Conference.
- Hang up.
- Page.
- Record Call.
- Compact / Normal View.
- Dial Pad.
- Access Conference Room 1.
- Access Conference Room 2.
- Options.

Directory Panel
- Call selected entry.
- View properties.
- Show directory.
- Show conferences.
- Show users in directory.
- Show groups in directory
- Show directory numbers.

Held Calls Panel
- Answer selected call.
- Answer longest held call.
- Conference held calls.
- Transfer selected call.
Trouble Shooting

Cannot send a message.
Contact your System Administrator. To be able to send a message, the operator's extension needs to be configured as a System Phone on the User | Telephony tab in the IP Office configuration. This is done using IP Office Manager.

Cannot use the 'Force Extension Status' or 'Group Service Status' features.
There is an interval of several seconds after SoftConsole has been started that the operator cannot use these features. During this interval the Directory Entry Properties or Group Service Status forms will display a close button, rather than the OK and Cancel buttons. Close the form, wait several seconds and then re-open the form to try again.

Unanswered Calls are Not Returned to the Operator
Contact your System Administrator. For calls to be returned to the operator when they are not answered, a Transfer Return Time must be set in the User | Telephony tab of the IP Office configuration using IP Office Manager.

Microsoft Outlook Warning Screen Appears at Login.
Cause:
If directory access to Microsoft Outlook contacts folder has been selected in the directories configuration form, a Microsoft Outlook warning screen might appear when an operator is opening SoftConsole or using the option 'Send Email'. If the warning screen appears:

1. Select the Allow access for checkbox, and then click an amount of time in the list.
2. Click Yes. Yes should always be selected to allow SoftConsole to retrieve Outlook contacts.

For more information refer to the Microsoft Support web site.

How to Export Directories.
Local Directory entries can be exported in a .CSV file format. The directory export facility applies not just to the local directory but to all directories that are shown in the directory panel. For example, if only the Show Users Entries button is depressed then only the user entries will be exported. If an existing filename is selected the original file contents are overwritten.

To export the operators Local Directory

1. From the Directory menu select Export
2. Enter a name for the file and click OK.

How Do I Delete a Profile.
Profiles can be removed if they are no longer required by:

1. From the File menu select Save Profile as.
2. Select the profile to be deleted.
3. Press Delete button.
4. When all profiles to be deleted have been removed, click Cancel to return to the Main screen.
Index

Destination 44
Destination Status 44
Status 44
Status Form 12
Forwarding 11, 12, 44
Forwarding Status 44
Full Name 11

G
Getting Started 6
Getting 6
Group Entries 11
Group Name 15
Group Service Status 15
Group Status 11, 44
Groups BLF 7
Out 44
Groups 7, 9, 11, 15, 16, 24, 31, 43, 44, 47, 50
Groups Configuration 43
Group’s Service 15

H
Hang Up 20, 22, 26, 29, 30, 31, 47, 50
Held 7, 22, 47
Held Call Panel 22
Held Calls 22, 29, 47, 50
Help file 47
Highlight New 17
Hold Current Call 47
Hold Against 29
Hold 19, 22, 24, 25, 26, 29, 31, 47, 50
Hold Against 22, 29
Hold Current Call 22
Hot 47
Hot Keys 47
Hunt Group Calls 24
Name 24, 42
Hunt Group 9, 11, 12, 24, 42, 44
Hunt Group Name 9
Hunt Group needs 42

I
Icons 16, 27
ID 23, 43
Idle 44
In Group 44
In Service 15
Including
Conferencing Center 28
SoftConsole 25
Including 25, 28
Incoming Call Handling 19
Calls Configuration 41
Large Display 5
Incoming 5, 9, 19, 41, 46
Intrude 29, 30, 32, 47
Invite button clicking 27
Invite button 27
Invited 27
IP Address 37, 38
IP Office
IP Address 37
IP Office 5, 6, 8, 11, 13, 23, 25, 28, 37, 38, 41, 44
IP Office Conference Center 25, 28
IP Office Control
Units 38
IP Office Directory
44
IP Office IP Address 37
IP Office SoftConsole 8, 41, 44
IP Office User 11
IP401 25
IP403 25
IP406 25
IP412 25

J
Joined 27

K
Keyboard Actions
Select 39
Keyboard Actions 39
Keyboard Actions Configuration 45
Keyboard Codes Use 16
Keyboard Codes 16
Keyboard Mapping 45
Keyboard Mapping Configuration 45
LAGAIN 32
Large Icons 16, 27
LCANCEL 32
LNEXT 32
Local Directory 41, 44, 51
Logged In 11, 16, 44
Logged Out 16, 44
Login 8, 37, 39, 50
Login Form Login Status 44
Refer 6
Login Form 6, 37
Login Status 44
Longest Time 47
Look SoftConsole 46
Look 46

M
Main 24
Main Menu Bar 8
Main Toolbar 50
Main Window 7, 17
Maximum Length 45
Media File 41
MENU pressing 32
MENU 32
MENU key 32
Microsoft Outlook selected 44
Microsoft Outlook 6, 35, 44
Microsoft Outlook Contacts Folder 44
Microsoft Outlook Contacts list 44
Mode 42
Move Down 42, 43
Move Up 42, 43
Msgs 32
My Profile
Automatically Save Changes 46
Save Changes 46
My Profile 46

N
N 23
Name 27, 47
Name Order 16
New 20, 21
New BLF Member dialog 17
New Call 20, 21
New Setting 47
Next Alerting Call Auto-Answer 47
Next Alerting Call No Answer 12
NoAns 20
Normal 42
Normal View 17
Not Disturb 11
Not Disturb Status Off 44
Notes 5, 6, 9, 12, 17, 20, 22, 30, 31, 34, 35, 39, 43, 44, 45, 47
Number Call Originator 9

O
Off-hook Station selected 37
Off-hook Station 37
OK 6, 17, 21, 30, 31, 32, 35, 38, 39
OK button 37
Open button 41
Open Directory File 41
Open Directory File button 41
Open Pop-up 45
Operator 5, 6
Options 35, 42, 45
Out Service 15
Outgoing 9, 46
Outgoing Calls 11, 20, 21
Outlook 6, 44
Outlook icon 44
Overview SoftConsole 5
Overview 5

P
Page 23, 29, 31, 47, 50
Park / Unpark Call 23, 47
Park ID 7, 23
Park Slot 7, 23, 24, 43, 47
Park Slot 10, 23, 47
Park Slot 11, 23, 47
Park Slot 12, 23, 47
Park Slot 13, 23, 47
Park Slot 14, 23, 47
Park Slot 15, 23, 47
Park Slot 16, 23, 47
Park Slot Button unpark 23
Park Slot Button 23
Park Slot ID 43
Park Slot List View 43
Park Slot Number 23
SoftConsole User Guide

IP Office 3.0

Issue 11c (4th February 2005)
Port Display Phones 32
Text Message Display on Avaya DT
Port Display Phones 32
These IDs 43
Timeout 22
Toolbar
control 8
Toolbars 7, 17
Tools menu 29, 34,
35, 42, 45
Transfer
call 20, 21
Press F3 21
Reattempt 47
Transfer Complete
20, 47, 50
Transfer Complete button 20
Trouble Shooting 51
Txt/rtf file 41
U
Unavailable 27
Unit
select 38
Unit 38
Unpark
Park Slot Button
23
Unpark 23
Unparked 23
Use
Keyboard Codes
16
SoftConsole’s Conference Rooms 25
Use 16, 25
User
Speak 30
Status 27
User 27, 30
User Name
Enter 17
User Name 11, 17,
20, 21, 37
Using 34
Using Conference Rooms 27
Using Hold 22
Using SoftConsole 26
V
View
Conferences/Addi
ing Users 28
Directory Properties 9, 50
Existing Conferences 25
View 9, 16, 17, 25,
27, 28, 50
View Active Conferences 9, 50
View Conference Rooms 8
View Directory Items 9, 50
View menu 8, 17, 39
Voicemail call 7
Connect 29
Transfer 47
Voicemail 5, 7, 8, 16,
20, 21, 24, 25, 27,
29, 32, 33, 44, 47
Voicemail Messages
16, 44
Voicemail Pro 25,
27, 31
W
Waiting Tone 37
WAV 41
Windows Start Button 6
WITHHELD 9
Y
Yellow 46
Yes 6, 44
Performance figures and data quoted in this document are typical, and must be specifically confirmed in writing by Avaya before they become applicable to any particular order or contract.

The company reserves the right to make alterations or amendments to the detailed specifications at its discretion. The publication of information in this document does not imply freedom from patent or other protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

This document contains proprietary information of Avaya and is not to be disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to "wgctechpubs@avaya.com".

© 2005 Avaya Inc. All rights reserved.

Avaya
Sterling Court
15 - 21 Mundells
Welwyn Garden City
Hertfordshire
AL7 1LZ
England

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933
Web: http://www.avaya.com